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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Division Digital Factory
Postfach 48 48
90026 NÜRNBERG
GERMANY
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LOGO! app 1
1.1 Function overview

The application enables the user to connect to a LOGO! 0BA7 or LOGO! 0BA8 via WLAN or 
Internet using a smart device.

Functions of your LOGO! app
● Configuring a control page for operator control and monitoring of tags with configurable

control types: Gauge, switch, bar graph, output field and slider. One control from each 
control type can be configured free of charge. If you require additional control of a type, 
these must be activated once by means of an in-app purchase. After the activation, as many 
controls of the relevant type as required can be configured. The maximum total number of 
controls is limited to 50.
NOTE: An Internet connection must be established in order to add controls to the control 
page. It is possible to use the controls without an Internet connection. 

● Displaying the operating mode of the controller 

● Displaying the IO status

● Displaying and acknowledging the diagnostic buffer

● Displaying Web pages on the Web server (only 0BA8)

● Monitoring and changing tags in a list (max. 20)

● Displaying up to eight tags in the trend view

● Languages: English and German

LOGO! App V.10
Operating Manual, 04/2016, A5E38071463-AA 5



Note

The local operation of the plant, for example, with LOGO! text display or SIMATIC Panel, is 
not affected by the LOGO! app and can be performed simultaneously.

High security
● Protected communication (for 0BA8)

● Password protection for the app

● Protected profile data

● Access to each individual LOGO! connection can be protected by a separate password.

Additional information on LOGO!
Additional information on the LOGO! controller is available at: www.siemens.com/logo.

Additional information SIMATIC to go
● You can find a brief introduction to the SIMATIC to go topic on YouTube:

YouTube (https://youtu.be/vXfRpnwZZu4)

● The SIMATIC to go page offers an overview of the other SIMATIC apps:
SIMATIC to go (http://www.siemens.com/simatic2go-qr2)

● You can find an overview of apps for different systems on the app page of the Online 
Support:
Link to Service & Support SIMATIC apps (https://support.industry.siemens.com/cs/ww/en/
view/84133612)

1.2 Downloading the LOGO! app

Installation of the app in iOS
You need at least iOS version 7.0 to use the LOGO! app.

Open the following link or scan the QR code:

LOGO! app
1.2 Downloading the LOGO! app
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Download link - LOGO! app iOS (siemens.com/app15)

Installation of the app in Android
You need at least Android version 4.0 to use the LOGO! app.

Open the following link or scan the QR code:

Download link - LOGO! app Android (siemens.com/app16)

LOGO! app
1.2 Downloading the LOGO! app
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1.3 LOGO! app icons

Overview - Icons in the LOGO! app
Refer to the following table to find out which functions the icons used in the LOGO! app have:

Icon Name Function
Edit Edit existing objects (e.g. tags).

Copy and paste Create a copy of the selected object.

Wrench Change the configuration of the app or a controller.

Plus Add objects

Cross Delete objects

Move Change the sorting of objects (such as tags) by holding the 
icon pressed and moving it to the desired location.

Floppy disk Save new or edited objects.

Back Navigate to the most recently opened dialog in the app.

Share Send data from the app.

Trend view Open trend view. This view displays process values over 
time.

LOGO! app
1.3 LOGO! app icons
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Icon Name Function
End full screen trend 
view

Ends the full screen view in the trend view.

Trend view standard 
zoom

Reset the zoom within the trend view to the standard setting.

Full screen trend view Starts the full screen view in the trend view.

Information Display information about the app.

LOGO! app
1.3 LOGO! app icons
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LOGO! app
1.3 LOGO! app icons
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Making basic settings and establishing a connection 
to LOGO! 2
2.1 Specify access of the app in LOGO! Soft Comfort

Introduction
Before using the access via the LOGO! app, you need to grant access permission in the 
respective LOGO! controller and specify a password for this access. 

You must make these settings in LOGO! SoftComfort V8 and load them to LOGO!.

Procedure
1. In LOGO!Soft Comfort V8, go to Tools > Transfer > Access control.

2. Under "Interface", select your connection to LOGO!.

3. Under Ethernet, enter the IP address of your LOGO!. For dynamic DNS, use the configured 
URL address. 

LOGO! App V.10
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4. Press Test to check if the connection was established successfully. If the connection was 
successful, press OK to load the program to the device.

5. Under File > Properties, go to the menu item "Access control settings", Online settings tab.

– Select the check box for Allow LOGO! App access.

– Select the check box for Enable password protection for LOGO! App access. 

– Assign a password. This password does not have to be the same as the password for 
the LOGO! connection. You assign the password for the LOGO! connection later on in 
the app.

– Click Apply to apply the password.

Making basic settings and establishing a connection to LOGO!
2.1 Specify access of the app in LOGO! Soft Comfort
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6. If you want to access the Web server with the LOGO! app, select Allow Web server 
access and assign a password.

7. Load the settings to the controller.

2.2 Starting the app and specifying a password

Introduction
The first time the app is started, you can set a password to use the app. The password is only 
used to log onto the LOGO! app. You can define the access to the respective LOGO! controller 
in the device overview.

Making basic settings and establishing a connection to LOGO!
2.2 Starting the app and specifying a password
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Procedure
The first time the LOGO! app is used, the following mask appears in which you can specify a 
password for the LOGO! app.

1. Assign a password and confirm with Save.

2. If you do not want to assign a password for the app, enter nothing and simply click Save.

Result
The password is required each time you open the app. The password can also be subsequently 
set or changed in the "Settings" mask.  

2.3 Setting up the connection to the LOGO! controller

Requirement
Access through the LOGO! app was permitted in LOGO! Soft.

If you want to access the Web server using the LOGO! app, you must permit Web server 
access in LOGO! Soft.

Making basic settings and establishing a connection to LOGO!
2.3 Setting up the connection to the LOGO! controller
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The port forward for port 8080 must be activated in the router of your network.

Core statement
1. Click on the plus symbol in the device overview.

The "Create Connection" dialog opens.

2. Select the type of your LOGO! controller (0BA7 or 0BA8).

3. In the "Name" field, enter a name with which the connection is displayed in the app. The 
name can be freely assigned.

4. Under "IP Address / Hostname" and "Port", enter the connection data to the controller.

Making basic settings and establishing a connection to LOGO!
2.3 Setting up the connection to the LOGO! controller
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5. If you want to control the Web server using the app (only with 0BA8), enter the Webserver 
user name and the password.

6. Click on the floppy disk icon to save the connection data.

Making basic settings and establishing a connection to LOGO!
2.3 Setting up the connection to the LOGO! controller
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Result
The controller is displayed in the device overview. Click on the controller to establish the 
connection.

Making basic settings and establishing a connection to LOGO!
2.3 Setting up the connection to the LOGO! controller
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Making basic settings and establishing a connection to LOGO!
2.3 Setting up the connection to the LOGO! controller
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Using the device overview 3
Starting point of the functions

The "Station Info" provides access to the following functions: 

● View status of inputs and outputs 

● View and change tag values 

● Set date and time of LOGO!

● Access to the Web server

LOGO! App V.10
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3.1 Displaying the IO status of inputs/outputs, bit memories and keys

Output of the I/O status
Under "IO State Selection", you access the status displays of the inputs and outputs, bit 
memories, LOGO! keys and text display. 

Using the device overview
3.1 Displaying the IO status of inputs/outputs, bit memories and keys
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Using the device overview
3.1 Displaying the IO status of inputs/outputs, bit memories and keys
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Example: Output of inputs
Click Inputs in the "IO State Selection". The output of the inputs is started automatically in the 
app.

● You can view newer or older process values by swiping down and up.

● You can show the other inputs by swiping left.

The set update rate determines how frequently the inputs are written. See also:Refresh 
frequency (Page 39)

Using the device overview
3.1 Displaying the IO status of inputs/outputs, bit memories and keys
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Using the device overview
3.1 Displaying the IO status of inputs/outputs, bit memories and keys
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3.2 Displaying and changing tags in the controller

Digital and analog network inputs
You can address digital and analog network inputs directly with the respective V address in 
the LOGO! app.

Analog FB parameters
To display or change analog FB parameters in the LOGO! app, you must enter these FB 
parameters in the parameter VM table in LOGO! Soft Comfort (menu item "Tools > Parameter 
VM Mapping") FB Parameters - Read only (actual value in LOGO!) FB Parameters - Read and 
write

Using the device overview
3.2 Displaying and changing tags in the controller
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Calling tags in the LOGO! app
1. In the "Station Info" mask, select "Tags" and click the plus symbol.

2. The "Add Tag" dialog opens. Enter the following data:

– Address: The address corresponds to the V address of your network input or FB 
parameter in the LOGO! program. 

– Name: Enter any name for the tag. The name is used only for display in the app.

– Format: Under Format, select the display format of the tag. For digital tags, select 
"BINARY"; for analog tags, select the required display format, e.g. "UNSIGNED".

3. Click on the floppy disk icon to save the tag.

The tag is displayed in the tag list. In the tag list, you can create a maximum of 20 tags for one 
LOGO!.

Using the device overview
3.2 Displaying and changing tags in the controller
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Changing the tag value
1. In the tag list, click on the tag with the value you want to change.

The "Change value on PLC" dialog opens.

2. Enter the desired value under "New Value". 

3. When you tap the "Write to LOGO!" button, the value from LOGO! is applied as the current 
tag value.

3.3 Outputting the IO status and tag status via the trend view

Introduction
Using the "Trend view" you can display the value changes of the IO status (inputs, outputs, 
etc.) and the tag over time.

A maximum of 8 tags can be displayed in the trend view at the same time. The supported data 
types are BIN, SIGNED, UNSIGNED and HEX.

● If you use the trend view to output the IO status, select the addresses of the inputs, outputs 
etc.

● If you use the trend view to output tags, select the tags from the tag list. 

Using the device overview
3.3 Outputting the IO status and tag status via the trend view
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Open the trend view
1. Click on the trend view icon in the tag list below in the dialog.

2. Use the check boxes to select the tags that you want to output via the trend view. Trend 
view starts as soon as you select the option for the tag.

3. Click on the arrow icon at the upper right to start the trend view in full screen mode.

Result
The value changes of your selected tags over time are displayed.

● By moving the blue slider to the left or right, you can display the tag values read.

● The exact values for the position of the slider are displayed below the coordinate system.

● You can use gestures to zoom in and out and use the standard zoom symbol to restore the 
original view.

How frequently a new value is written depends on the refresh frequency. You can adjust this 
in the app settings.

Using the device overview
3.3 Outputting the IO status and tag status via the trend view
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Using the device overview
3.3 Outputting the IO status and tag status via the trend view
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3.4 Setting date/time

Date and time
You can set the date and the time individually using the "Set Clock on PLC" selection in the 
Station Info.

3.5 Working with the Web server

Logging on to the Web server
Open the Web server via Station Info, enter the name and the password for Web server access, 
and click Log on.

You can open the following Web server functions from the drop-down list:

● LOGO! system: System overview 

● LOGO! tag: Displaying and changing tags

Using the device overview
3.5 Working with the Web server
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● LOGO! BM: Controlling the LOGO! basic module

● LOGO! TD: Reading out the LOGO! text display

Using the device overview
3.5 Working with the Web server
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LOGO! system 
You read out the device data of your LOGO! via the system overview.

Using the device overview
3.5 Working with the Web server

LOGO! App V.10
Operating Manual, 04/2016, A5E38071463-AA 31



Editing a LOGO! tag
You read out the tags of your LOGO! and change the tag values under "Edit LOGO! tag".

LOGO! BM and LOGO! TD
The functions LOGO! BM and LOGO! TD will only be available as of the next app version:

● The display messages of the LOGO! basic module are output under "LOGO! BM" over the 
Web server.

● The contents of the text display can be output under the LOGO! TD option. 

Using the device overview
3.5 Working with the Web server
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Creating controls 4
4.1 Control overview

How controls work
Controls are graphical control elements for reading and writing PLC tags. You can configure 
up to 50 controls in your LOGO! app.

Controls are always linked to a tag whose value is to be changed or output via controls.

The list of controls can include multiple controllers and their tags.

Enabling controls
For testing purposes, you can use a given control of any type once free of charge. Thereafter, 
activation of the control type is subject to charge.

Once you have activated a control element, you can use this type in your app as often as you 
like.

The activation of the control type is stored in your app store under your account. When you 
change the device, you can continue to use the control type at no additional cost.

Requirement
To use a control, you must have previously created a tag for LOGO!.

See also: Displaying and changing tags in the controller (Page 24)

Control types
There are five different controls that you can use:

● Button: For switching between two values of a tag

● Slider: For changing analog values

● Bars: Output of analog values

● Output field: Output of analog values

● Gauge: Output of analog values with indication of critical value ranges
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4.2 Adding a control button

Example: Control button
One use for the control button is an on/off switch for a motor.

Adding controls
1. Click on the plus symbol on the control page.

2. Select the control button.

3. Enter the following information under "Edit button":

– Edit control name: Name under which the control is shown in the app. The name of the 
control is independent of the tag name.

– Name left / right: Label in the app for the left and right button of the control

– Select PLC: Selection of the CPU that contains the tag for the control.

– Target Tag: Tag to be displayed and controlled via the control.

– Value left / right: Value to be written by the left or right button.

– Shows indicator field (optional): The indicator field outputs the value of a tag.

– Current tag: Tag in the controller whose value is to be output.

– Text in indicator field: Text to be displayed for a given tag value (for example, "Motor 
off" for tag value "0"). 

– Value for text: Tag value.

4. Click on the floppy icon at the upper right to save the control.

Result
The control is displayed on the control page. You can use the icon to the right of the control 
to edit, delete or duplicate the control.

Creating controls
4.2 Adding a control button
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4.3 Adding a control slider

Example: Control slider
One use for the control slider is changing a fill level or speed (change of analog values).

Adding controls
1. Click on the plus symbol on the control page.

2. Select the "Slider" control.

3. Enter the following data under "Edit slider":

– Edit control name: Name under which the control is shown in the app. The name of the 
control is independent of the tag name.

– Min./Max. Value: Value range that can be written using the slider. If the process value 
violates the value range, an arrow is shown to the right or left of the slider.

– Select PLC: Selection of the CPU that contains the tag for the control.

– Target Tag: Tag to be displayed and controlled via the control.

– Select Auto scaling / Number of segments: Specify whether the slider is to be divided 
into a fixed number of segments or if the app should set the number of segments 
automatically.

– Show current value: The current value is displayed next to the slider. The tag for the 
current value does not correspond to the target tag in this case.

4. Click on the floppy icon at the upper right to save the control.

Result
The control is displayed on the control page. You can use the icon to the right of the control 
to edit, delete or duplicate the control.

Creating controls
4.3 Adding a control slider
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4.4 Adding control bars

Example: Control bars 
One use for the control bar is displaying a fill level or speed (display of analog values).

Adding controls
1. Click on the plus symbol on the control page.

2. Select the "Bar" control.

3. Enter the following data under "Add bar":

– Add control name: Name under which the control is shown in the app. The name of the 
control is independent of the tag name.

– Min./Max. Value: Value range that can be written using the slider. If the process value 
violates the value range, an arrow is shown to the right or left of the bar.

– Select PLC: Selection of the CPU that contains the tag for the control.

– Target Tag: Tag to be displayed and controlled via the control.

4. Click on the floppy icon at the upper right to save the control.

Result
The control is displayed on the control page. You can use the icon to the right of the control 
to edit, delete or duplicate the control.

4.5 Adding a control output field

Example: Control output field
Any type of value can be displayed via the output field. One use for the output field control is 
to output a status value of an instruction.

Creating controls
4.5 Adding a control output field
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Adding controls
1. Click on the plus symbol on the control page.

2. Select the control in the output field.

3. Enter the following information under "Edit button":

– Edit control name: Name under which the control is shown in the app. The name of the 
control is independent of the tag name.

– Select PLC: Selection of the CPU that contains the tag for the control.

– Target Tag: Tag to be displayed and controlled via the control.

4. Click on the floppy icon at the upper right to save the control.

Result
The control is displayed on the control page. You can use the icon to the right of the control 
to edit, delete or duplicate the control.

4.6 Adding a gauge control

Example: Gauge control
One use for the gauge control is to display the speed for a motor.

Adding controls
1. Click on the plus symbol on the control page.

2. Select the control in the output field.

Creating controls
4.6 Adding a gauge control
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3. Enter the following information under "Edit button":

– Edit control name: Name under which the control is shown in the app. The name of the 
control is independent of the tag name.

– Title: Text that is displayed in the control itself (for example: "Speed" or "km/h").

– Min./Max. Value: low and high values of the displayed scale. If the process value violates 
the value range, an arrow is shown to the right or left of the pointer instrument.

– Start value warning / start value danger: Value as of which the scale is highlighted in 
yellow or red.

– Select PLC: Selection of the CPU that contains the tag for the control.

– Target Tag: Tag to be displayed and controlled via the control.

4. Click on the floppy icon at the upper right to save the control.

Result
The control is displayed on the control page. You can use the icon to the right of the control 
to edit, delete or duplicate the control.

Creating controls
4.6 Adding a gauge control
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Settings and project information 5
5.1 Change language

Language selection
1. Open settings of the app on the start screen by clicking on the wrench icon at the bottom 

left.

2. Click Language selection.

3. Select your language (English or German).

4. Click on the floppy icon at the upper right to save the settings.

Result
The language of the app has been switched.

Note that the language switch only affects the app. Project texts from TIA such as diagnostic 
buffer entries are displayed in the configured project language of the controller.

5.2 Refresh frequency

Refresh frequency
You use the refresh frequency to determine how often a process value is to be read from the 
controller.

Set the refresh frequency
1. Click Refresh frequency on the "Settings" page.

2. Select the refresh frequency between 0.5 and 30 seconds.

3. Save the refresh frequency with floppy icon at the upper right.

Result
The display of the values in the tag list, the trend view or in the controls are updated according 
to the selected setting.
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5.3 Changing your password

Password protection of the S7 app
The S7 app itself can be protected by a password. The password protection prevents 
unauthorized access to the controller via the app.

When you first start the app, you can optionally assign a password:

● If you skipped this step, you can use the "Change Password" dialog at any time to assign 
a password.

● If you have already assigned a password, you can change or delete your password via the 
dialog.

Setting a password
1. Leave the "Old password" empty.

2. Enter your desired password for the app under "New password".

3. Enter and confirm the new password and click Save.

Changing your password
1. Enter your password in the "Old password" field.

2. Enter your desired password for the app under "New password".

3. Enter and confirm the new password and click Save.

Delete password
1. Enter your password in the "Old password" field.

2. Leave the other two fields empty and click Save.

Settings and project information
5.3 Changing your password
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